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Installing, Using and Testing Microsoft Windows 
Driver Kit (WDK) 

 

What do we have in this session? 

 

Introduction 

Installing the WDK 

The Windows Debuggers 

Installing Symbols Package 

The WinDbg 

Starting WinDbg 

Verifying WDK Installation  

Steps on Using WDK and Building Windows Driver from Code Sample 

Building a Windows Driver Sample 

Drivers and Services 

Installing/Registering a Driver 

Starting a Driver 

Viewing Driver Output 

Unloading a Driver 

Print Devices: Generic Text-Only Driver Sample 

Useful WDK references: 

 

 

Introduction 

 

The Windows machine specification used in this session are: 

 

1. Operating System : Windows XP Pro SP2 

2. RAM  : 2 GB DDR2 

3. HDD  : 160++GB 

4. Display  : 128 MB ATI PCI Express 

5. Processor  : Intel Core 2 Duo 4400 2.00 GHz 

 

The DDK has been superseded by the Windows Driver Kit (WDK). While the DDK can 

be downloaded openly, you may need to register for free and participate in the respective 

Microsoft community to download WDK. Microsoft said that the WDK should be used 

for the following reasons: 

 

1. Use the Windows Vista build environments in the WDK to build drivers that use 

new features or functionality available only in Windows Vista. 

2. Use the Windows Server 2003 build environments in the WDK to build drivers 

that use new features or functionality available only in Windows Server 2003. 

3. Use the Windows XP build environments in the WDK to build drivers that do not 

use new functionality available only in Windows Vista or only in Windows 

Server 2003 and that are targeted for either Windows XP or Windows Server 
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2003 and Windows XP. The Windows XP build environments in the WDK 

contain minor updates to the Windows DDK that shipped with Windows XP SP1 

and with Windows XP. 

 

You should use the Windows 2000 build environments in the WDK to build drivers 

designed to run on Windows Vista, Windows Server 2003, Windows XP, or Windows 

2000. The Windows 2000 build environment in the WDK includes updated headers and 

libraries for Windows 2000 Service Pack 4 (SP4). 

 

Installing the WDK 

 

Firstly, go to the WDK site to download the ISO. If you download the ISO, you need to 

burn it on the CD to make it useable. If needed, you can rename the .ISO extension 

to .IMG. If you want to get an idea how to install/extract the .IMG/.ISO files, go to this 

link. Newer DVD/CD-ROM can read directly the ISO, so no need for us to burn it and 

you can skip the ISO burning steps. 

Then we are ready to install the WDK. Insert the previously burned ISO CD into the 

DVD/CD-ROM drive and the autorun should be launched welcoming you with the 

following splash screen. Click the splash screen. 

 

 
 

http://www.microsoft.com/whdc/DevTools/WDK/WDKpkg.mspx
http://msdn2.microsoft.com/en-us/express/aa718401.aspx
http://msdn2.microsoft.com/en-us/express/aa718401.aspx
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Select the features that need to be installed. In this case we select all the features. When 

you select any of the features, the description will be in the bottom window. Click the OK 

button to continue. 

 

 
 

Next, the default path was given to us. Edit or use the Browse button if you need to 

modify the installation path. In this case we just accept the given path. Click the OK 

button. 

 



  www.installsetupconfig.com 

4 

 

 
 

Accept the EULA and click the OK button. 

 

 
 

The installation progress window will start. You can cancel the installation any time. 
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Just accept the Device Simulation Framework (DSF) warning page. 

 

 
 

The installation should begin. Just wait until it finish. 

 

 
 

 

 
 

 



  www.installsetupconfig.com 

6 

 

 

If there is no error, the installation should be completed successfully at this stage. Any 

error should be welcomed with Windows error message and you should take appropriate 

action for re-installation. 

Then you can verify the installation through the Start menu as shown below. 

 

 
 

The Windows Debuggers 

 

Debugging Tools for Windows features WinDbg, a powerful debugger with a graphical 

interface that can debug both user-mode and kernel-mode code. Debugging Tools for 

Windows also includes: 

 

1. KD  - Command-line kernel debugger. 

2. NTSD  - Command-line user-mode debugger. 

3. CDB  - Command-line user-mode debugger (variant of NTSD). 

 

and many additional tools as listed in the following Table. 

 

Tool Description 

Logger  (Logger.exe and 

Logexts.dll) 

A tool and an extension DLL that record the 

function calls and other actions of a program. 

LogViewer  (Logviewer.exe) A tool that displays the logs created by Logger. 

ADPlus  (Autodump+, 

Adplus.vbs) 

A console-based Microsoft Visual Basic script 

that can automatically create memory dump files 

and log files with debug output from one or 

more processes. 

DbgRpc  (Dbgrpc.exe) 
A tool used to display Microsoft Remote 

Procedure Call (RPC) state information. 

KDbgCtrl  (Kernel Debugging 

Control, Kdbgctrl.exe) 

A tool that controls and configures the kernel 

debugging connection. 

SrcSrv (Srcsrv.dll) 
A source server that can be used to deliver 

source files while debugging. 

SymSrv  (Symsrv.dll) 
A symbol server that the debugger can use to 

connect to a symbol store. 

SymStore  (Symstore.exe) A tool used to create a symbol store. 

SymProxy 

A tool used to create a single HTTP symbol 

server on your network that all your debuggers 

can point to. This has the benefit of pointing to 
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multiple symbol servers (both internal and 

external) with a single symbol path, handling all 

authentication, and increasing performance via 

symbol caching. 

AgeStore  (Agestore.exe) 

A tool that removes old entries in the 

downstream store of a symbol server or a source 

server. 

DBH  (Dbh.exe) 
A tool that displays information about the 

contents of a symbol file. 

PDBCopy  (Pdbcopy.exe) 

A tool that removes private symbol information 

from a symbol file, and controls which public 

symbols are included in the file. 

DumpChk  (Dump File Checking 

Utility, Dumpchk.exe) 
A tool used to validate a memory dump file. 

DbgSrv  (Dbgsrv.exe) A process server used for remote debugging. 

KdSrv  (Kdsrv.exe) 
A KD connection server used for remote 

debugging. 

DbEngPrx  (Dbengprx.exe) 
A repeater (small proxy server) used for remote 

debugging. 

The Remote tool  (Remote.exe) 

A remoting tool that can be used to remotely 

control any console program, including KD, 

CDB, and NTSD. 

GFlags  (Global Flags Editor, 

Gflags.exe) 

A tool used to control registry keys and other 

settings. 

The Kill tool  (Kill.exe) A tool used to terminate a process. 

The Breakin tool  (Breakin.exe) 
A tool used to cause a user-mode break to occur 

in a process. 

The List tool (List.exe) File List Utility 

TList (Tlist.exe) Task List Viewer 

RTList (Rtlist.exe) 
Remote Task List Viewer. A tool used to list 

running processes via a DbgSrv process server. 

UMDH  (User-Mode Dump Heap 

utility, Umdh.exe) 
A tool used to analyze heap allocations. 

USBView  (Universal Serial Bus 

Viewer, Usbview.exe) 

A tool used to display the USB devices 

connected to a computer. 

 

The documentation in Debugging Tools for Windows (Debugging Help) describes the 

use of these debuggers and includes tips for user-mode and kernel-mode debugging. 

Debugging Tools for Windows is available in three different versions: 

 

1. A 32-bit version. 

2. A native Intel Itanium version, and 

3. A native x64 version. 

 

The 32-bit version is appropriate for most users. If you are planning on debugging a user-

mode application on an Itanium-based processor, you should install the Itanium version 
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of the debuggers. If you are planning on debugging a user-mode application on an x64 

processor, you should select the x64 version of the debuggers. The Itanium and x64 

debuggers can be installed only on 64-bit versions of Windows. These debugging tools 

require approximately 25 MB of hard disk space. 

To obtain the most current version of Debugging Tools for Windows, visit the Microsoft 

Debugging Tools web site. It seems that the Debugging Tools for Windows (x86) was 

installed together during the WDK installation. 

 

 
 

Installing The Symbols Package 

 

As said by Microsoft, the new linker strips all the debug information from the SYS file 

and moves the data into a PDB file. The PDB file should be copied to the symbols 

directory for debugging. Copying the SYS file will not provide debugging information. If 

you want the entire set of symbols for Windows Vista, Windows Server 2008, Windows 

XP, or Windows 2000, then you can download a symbol package and install it on your 

computer. 

 

http://www.microsoft.com/whdc/ddk/debugging/default.mspx
http://www.microsoft.com/whdc/ddk/debugging/default.mspx
http://www.microsoft.com/whdc/devtools/debugging/symbolpkg.mspx
http://www.microsoft.com/whdc/devtools/debugging/symbolpkg.mspx
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Selecting Windows XP with Service Pack 2 retail symbols for downloading 

 

In our case, because we can’t be online all the time, we have downloaded a package for 

Windows XP SP2 symbols package and run the executable file (~ 200MB). 

 

 



  www.installsetupconfig.com 

10 

 

 

The Windows XP with Service Pack 2 retail symbols self-extraction file 

 

 
 

The Windows XP with Service Pack 2 retail symbols file extraction 

 

 
 

The Windows XP with Service Pack 2 retail symbols License agreement 

 

The default installation path was given for us. If you want to change the path, please use 

the Browse button. 
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The Windows XP with Service Pack 2 retail symbols default installation path 

 

 
 

The Windows XP with Service Pack 2 retail symbols custom directory installation 

selection 

 

 
 

The Windows XP with Service Pack 2 retail symbols package installation path 

 

The symbol package installation should start shortly. 

 



  www.installsetupconfig.com 

12 

 

 
 

The Windows XP with Service Pack 2 retail symbols files copying in action 

 

If there is no error, you should be welcomed by the following Windows message. 

 

 
 

The Windows XP with Service Pack 2 retail symbols package installation is complete 
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The Windows XP with Service Pack 2 retail symbols installed directories 
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The Windows XP with Service Pack 2 retail symbols PDB files 

 

The WinDbg 

 

After executing windbg, you need to set the path to the symbol files. This path points to 

the directories with the pdb files of your drivers. You can have different directories by 

separating them with a semicolon (;). You also need to point to the corresponding PDB 

files of all the windows components, if you want the call stacks that you'll see to include 

the functions from the components that are developed by Microsoft. 

However, the problem in this case is that the windows PDB files change between service 

packs, hotfixes, etc. Fortunately, Microsoft has configured a symbol server, which can be 

used to download the needed files on-demand. This means that you just set the 

symbol path to the symbol server and windbg downloads only the PDB files that it needs. 

In order to do this, you need to add an entry to the windbg symbol path that's equal to: 

 
SRV*DownstreamStore*http://msdl.microsoft.com/download

/symbols 

 

In the above line, http://msdl.microsoft.com/download/symbols is the 

symbol server (you don't need to modify this), and DownstreamStore is the path, 

where you want the pdb files to be downloaded. This needs to be substituted by a local 

directory, e.g. C:\Symbols, so the complete entry would be: 

 
SRV*c:\Symbols*http://msdl.microsoft.com/download/symb

ols 
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Setting the Symbol File Path 

 

 
 

Setting the PDB Symbol File Path for the on demand download 
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Finally, if you have additional pdb files for the drivers that you are developing in 

directories C:\mydrivers1, C:\mydrivers1\misc and C:\mydrivers2, the 

complete symbol path would be: 

 
SRV*c:\websymbols*http://msdl.microsoft.com/download/symbol

s;c:\drivers1;c:\drivers1\misc;d:\drivers2 

 

Also, as it can be seen from the above example, the directories in the path aren't recursive, 

so if you have PDB files both in C:\mydrivers1 and C:\mydrivers1\misc, then 

you need to include both of them, since the format doesn't imply the latter. 

In order to set this line, you need to open windbg, go to File → Symbol File 

Path and paste the line in the text area. 

In our case the PDB files already installed under the C:\Symbols directory, so we just 

point to the directory in the Symbol File Path. 

Launch the Windbg program. 

 

 
 

Invoking the Symbol File Path setting page 
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The Symbol File Path setting page 

 

 
 

Selecting the C:\Symbols as the Symbol File Path 
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The Symbol File Path has been set to the local C:\Symbols directory 

 

Don’t forget to save the changes that have been done. 

 

 
 

Saving the WinDbg changed workspace 

 

More complete information should be found in the Help. 
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Invoking the WinDbg Help 

 

 
 

The WinDbg Help 

 

Kernel-mode memory dump files can be analyzed by WinDbg. The processor or 

Windows version that the dump file was created on does not need to match the platform 

on which KD is being run. 

 



  www.installsetupconfig.com 

20 

 

Starting WinDbg 

 

To analyze a dump file, start WinDbg with the -z command-line option: 

 
windbg -y SymbolPath -i ImagePath -z DumpFileName 

 

The -v option (verbose mode) is also useful. If WinDbg is already running and is in 

dormant mode, you can open a crash dump by selecting the File → Open Crash 

Dump menu command or pressing the CTRL+D shortcut key. 

 

 
 

Opening the Windows Crash Dump file 

 

When the Open Crash Dump dialog box appears, enter the full path and name of the 

crash dump file in the File name text box, or use the dialog box to select the proper 

path and file name. When the proper file has been chosen, click Open. 
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Selecting the Windows mini Crush Dump file 

 



  www.installsetupconfig.com 

22 

 

 
 

You can also open a dump file after the debugger is running by using 

the .opendump (Open Dump File) command, followed with g (Go). 

Dump files generally end with the extension .dmp or .mdmp. You can use network 

shares or Universal Naming Convention (UNC) file names for the memory dump file. 

Well, it will take a long story to provide examples on how to debug either the user mode 

or kernel mode and why not you try the following links by Windows device driver 

developer for more information. 

 

1. A Crash Dump analysis tutorials. 

2. Windbg basic tutorials. 

3. Tips on how to analyze strange Crash Dumps and uninstall the Windows hidden 

drivers. 

 

Verifying WDK Installation  

 

To verify that you have properly installed the Windows Driver Kit (WDK), complete the 

following steps: 

 

1. Start a Windows XP Checked Build Environment Command Prompt 

window: 

http://blogs.msdn.com/iliast/archive/2006/12/11/crash-dump-analysis.aspx
http://blogs.msdn.com/iliast/archive/2006/12/10/windbg-tutorials.aspx
http://blogs.msdn.com/iliast/archive/2007/01/11/tips-on-how-to-analyze-strange-crash-dumps-and-uninstall-hidden-drivers.aspx
http://blogs.msdn.com/iliast/archive/2007/01/11/tips-on-how-to-analyze-strange-crash-dumps-and-uninstall-hidden-drivers.aspx
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a. Click the Start button, and then click All Programs. 

b. Point to Windows Driver Kits, point to your selected WDK XXXX, 

point to Build Environments, and then point to Windows XP (or your 

chosen Windows OS). 

c. Click Windows XP Checked Build Environment to create the build 

environment for the chosen Windows platform. 

 

 
 

Running the Checked Build Environment for Windows XP 

 

2. At the command prompt, type build –cZ to compile and link the complete set of 

installed sources. This command can take more than 30 minutes to complete, 

depending on which WDK components are installed and the system on which the 

build is being performed. 

 

 
 

Running the build command 
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The Checked Build Environment for Windows XP in action 
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More action for the Checked Build Environment for Windows XP 

 

3. The build command should complete with no errors and/or warnings displayed as 

shown below. 
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The Checked Build Environment for Windows XP is completed without any error. 

 

By invoking the PREFast, you can see the warnings and errors in details (if any). 

 

 
 

The warnings and error can be seen by invoking the menus by right-clicking the icon tray. 
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The next tutorial, will try to demonstrate the steps on how to build the Windows driver 

using a given sample code. 
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Steps on Using WDK and Building Windows Driver from Code Sample 

 

Firstly create an empty directory to store your driver project in C drive. Use a simple path 

with no spaces in it, just because it is easier to navigate from the command-prompt. For 

example: 

 
C:\MYDRIVERS\HELLO\ 

 

In the HELLO folder create the following subfolders for organizing our project. 

 

SRC – for source code files 

BIN – for binary files 

LIB – for custom made or extra library files 

INC – for include files 

 

 
 

Create an empty text file in the SRC directory and call it "hello.c", then type the 

following code into it. 

 
#include <ntddk.h>  

 

NTSTATUS DriverEntry(PDRIVER_OBJECT DriverObject, PUNICODE_STRING 

RegistryPath)  

{ 

 DbgPrint("Hello WDK World!\n"); 

 return STATUS_SUCCESS; 

} 
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The DriverEntry() is a function required by the WDK - it is similar in concept to 

DllMain() because it is called when your driver first loads - however your driver remains 

loaded after you return back to the kernel. 

The two parameters are worth mentioning. DriverObject is a pointer to a 

DRIVER_OBJECT structure, a kernel data structure used to represent the loaded device 

driver. RegistryPath() is a Unicode string which holds the corresponding service entry 

location in the registry. 

Unlike win32 programs which use BOOL return types, and TRUE and FALSE, kernel 

drivers use NTSTATUS return types. This is a 32bit value which can hold many different 

error codes and severity levels. The value STATUS_SUCCESS (which is zero) is used to 

indicate a successful returns value. Other STATUS_xxx codes can be found in the 

ntstatus.h header file. Note that, if we return anything other than STATUS_SUCCESS 

from DriverEntry, our driver will fail to load 

 

Building a Windows Driver Sample 

 

Assuming that you have created your project directory, you need to create two more files 

which the WDK build utility requires in order to build your project. The first file you 

need to create is called "MAKEFILE" - note that there is no extension on this filename. 

MAKEFILE should contain a single line (shown below): 

 
!INCLUDE $(NTMAKEENV)\makefile.def 

 

and must never be edited in any way. Usually the WDK samples include such a file, so 

you can copy it straight from there. Use WordPad to edit the file. 
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Don’t forget to save the file and click Yes for the following warning splash screen if any. 
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The second file you need to create is your main project file, called "SOURCES", again 

with no file extension. The contents of this file direct the WDK build utility to your 

source code files. 

SOURCES contains two important pieces of information - the name of your driver, and a 

list of source-files. If you have more than one source-file, then they should be listed one-

after-the-other on the same line, separated by a space. You have to be careful with 

filenames that contain spaces (i.e. use quotes), so it is easiest just to use simple names. 

Put the following codes in the SOURCES file and save it. 

 
TARGETNAME = hello 

TARGETPATH = obj 

TARGETTYPE = DRIVER 

INCLUDES   = %BUILD%\inc 

LIBS       = %BUILD%\lib 

SOURCES    = hello.c 

 

 
 

The SOURCES file template can be found at SOURCES file template. 

Building a driver is very simple once you have created a driver project. At this point you 

should have three files in your project directory - hello.c, SOURCES and MAKEFILE. 

Open up the x86 Checked Build Environment for Windows XP (the WDK command-

prompt) and go to the project SRC folder and type "build". 

 

 
 

 

http://msdn.microsoft.com/en-us/library/ms792417.aspx
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The following Figure shows the created folders and files after the building steps were 

completed successfully. 
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Drivers and Services 

 

Installing and executing a driver is quite a bit different than running a "normal" program 

from the command line. There is no concept of running a new process because a driver is 

a kernel module which lives permanently inside the system. Two steps are required to get 

a driver installed: 

 

1. Registering the driver as a system service, and then 
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2. Starting the driver. 

 

This is usually the area that confuses people who are not used to working with drivers. A 

driver is treated by Windows as a regular service which can be started and stopped just 

like any other service. The Windows component that controls all this is called the Service 

Control Manager (SCM) which you have learned in the other topic (Windows Service). 

This component exposes an API which can be used to register, unregister, and start & 

stop drivers and regular Win32 services. 

Actually registering a driver and starting it can be a little confusing if you've not done it 

before. However for beginners, there are several tools that can be used to automate these 

processes. For example: 

 

http://www.osronline.com/ - osrloadervxx 

http://www.rootkit.com/ - InstDrv, an advanced_loader 

 

This handy tool allows you to register, start, stop and unregister drivers, all from a single 

GUI. The following Figure shows InstDrv tool 

 

 
 

In this tutorial we will use osrloader version 3.0. Launch the executable. 

 

 
 

 

 

http://www.osronline.com/
http://www.rootkit.com/
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Click the Browse button and set the path to the hello.sys file. 
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Installing/Registering a Driver 

 

There are two ways to register a driver as a system service. The first (and easiest) is to 

use the CreateService() API which is documented in MSDN. But basically all this does is 

create a few values in the Registry on your behalf. The second method is to manually 

create these values however this step is not recommended. In this tutorial we are using a 

tool that makes our tasks automated. 

Note that a driver only needs to be registered once (it can only be registered once) - and 

can be started and stopped as many times as you like after this. 

Click the Register Service button to register/install the driver. 
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Starting a Driver 

 

Once a driver has been registered as a system-service, it can be loaded (and unloaded) 

using the Service Control Manager (SCM). In this tutorial we will use osrloader by 

clicking the Start Service button. 
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You can start a driver programmatically using the StartService() API call, but it is far 

easier to goto the command-prompt and type: 

 
net start hello 

 

The following output will then be displayed: 

 

The hello service was started successfully. 

 

Nothing else will appear to happen though because drivers don't (and can't) output any 

data to the console. Note that at this point the driver has been loaded into kernel-space 

and your DriverEntr() function has been executed. 

There are several types of the service start as shown below. 
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Click the Active Services button to verify that our driver has been loaded and running. 
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Open registry editor (regedt32) and search the hello word. 

 

 
 

Next, click Start > all Programs > Accessories > System Tools > System Information 
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Viewing Driver Output 

 

For debugging purposes it is common for drivers to use the DbgPrint() API to emit debug 

messages. The syntax is given below. 

 
ULONG DbgPrint(const char *fmt, ...); 

 

DbgPrint() is very similar to the regular printf() routine, the difference being that it can 

only be called from kernel mode. The debug messages, instead of displaying on the 

screen, are sent to the kernel debugger (usually WinDbg), assuming that one is attached. 

 

Unloading a Driver 

 

Stopping (and unloading) a driver is as simple as starting it using the net command: 

 
net stop hello 

 

However the driver we have built at this point will never unload, because we have 

omitted a tiny detail. The one thing we left out was the DriverUnload() routine, which the 



  www.installsetupconfig.com 

43 

 

service-control-manager calls when a driver is about to unload. This unload routine must 

be specified during DriverEntry() if our driver is to be unloadable, and a pointer to the 

routine stored in the DriverObject: 

 
#include <ntddk.h> 

 

void DriverUnload(PDRIVER_OBJECT pDriverObject) 

{ 

 DbgPrint("Driver unloading...\n"); 

} 

 

NTSTATUS DriverEntry(PDRIVER_OBJECT DriverObject, PUNICODE_STRING 

RegistryPath) 

{ 

    DbgPrint("Hello, World! Driver loaded!\n"); 

    DriverObject->DriverUnload = DriverUnload; 

 

    return STATUS_SUCCESS; 

} 

 

Modify your basic driver source code by adding the above code. 

 

 
 

You will have to rebuild the driver. 
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To clean-up all the 'mess' done, reboot your computer. 

In our case to simplify the steps to view the verbose output of the driver based on using 

the DbgPrint(), we use DebugView tool. DebugView tool can be downloaded from 

Microsoft technet. 

Run this tool and enable the Capture settings as shown below. 

 

http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx
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Next, run the osrloader as done previously. Register and start the Hello driver. 
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Notice the DebugView messages. 
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Then, you also are able to use "net start" and "net stop" as often as you like to start and 

stop the driver. 

 

 
 

Print Devices: Generic Text-Only Driver Sample 

 

The sample codes for various Windows device drivers can be found under the Windows 

Driver Kit installation if the sample code module has been selected during the WDK 

installation. Those Windows driver sample source codes can be found under the SRC 

subfolder: 

 
C:\WinDDK\7600.16385.0\src 
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The online version can be found at Windows Driver Code Sample. In this exercise we 

will try building a sample generic text-only printing driver. The Generic Text-Only 

Driver (TTY) sample demonstrates how to implement a print driver that is Unidrv-based, 

generic, and text-only.  

http://msdn.microsoft.com/en-us/library/dd419686.aspx
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The TTY driver is a generic, text-only driver. It prints only text, and it prints the text in 

the native font of the print device, regardless of any formatting in the original document. 

The TTY driver sample uses the same source files as in the in-box driver, which means 

you can expect the same output as the in-box generic text-only driver when you build and 

install this sample. 

The following Figures show the SOURCES, MAKEFILE and dirs files content. 

 

 
 

http://msdn.microsoft.com/en-us/library/ms792417.aspx
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To create a version with verbose debug output, add WPP_DEBUG to the compile defines 

in the sources file. 

To build the samples, run build -cZ from each directory (RC, UI, and Render). The DLLs 

are placed in the appropriate platform directory (that is, i386). 

Open the Windows XP Check Build Environment. 

 

 
 

 

Run the build –cZ command from RC, UI and Render directories. 
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After building the samples, you can install the samples by using the Add Printer wizard. 

Select the local printer, click Have Disk, and point to the directory that contains the 

tty.inf file (this file already provided for us and may need some modification, for example 

the path of some of the file. We do nothing in this case). Microsoft Windows 2000 and 

later drivers do not need to be copied to the local directory that contains tty.inf. 

The following Figures show the steps on how to install the printer driver as we do for 

Windows. 
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If there is error stating file cannot be found, point to the appropriate folder. 
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Useful WDK references: 

 

1. Advanced Driver Debugging (PPT by Microsoft) 

2. Windows Device Driver Development (PDF – simplified steps) 

3. WDK Build Utility Reference (MSDN) 

 

http://www.google.com.my/url?url=http://download.microsoft.com/download/f/0/5/f05a42ce-575b-4c60-82d6-208d3754b2d6/Adv-Drv_Debug.ppt&rct=j&ei=x3tAS4qPHYf-tQP1z_C-BA&sa=X&oi=spellmeleon_result&resnum=1&ct=result&ved=0CAcQhgIwAA&q=SOURCES+_DEBUG+driver&usg=AFQjCNE7wA9K7QLqlK4Del88SjhUe2X2lA
http://appletree.or.kr/quick_reference_cards/Windows/Windows%20Device%20Driver.pdf
http://msdn.microsoft.com/en-us/library/ms792380.aspx

